The New Piezography® Users Manual

This is a manual for using QuadTone RIP (QTR) correctly with Piezography K7 and K6 curves. Piezography requires a different method of printing with QTR than is described in the QTR manual that is provided with the download of QTR. Please follow this manual if you wish to use this product the way it is intended to be used.

Table of Contents

What is Piezography?
Installing Piezography inks in your printer
The Piezography Media Profiles
QuadTone RIP Installation on Mac OS X
Windows Installation of Quad Tone RIP
Piezography Workflow Background
Lets Get Ready to Print!
Using the Quad Tone RIP Print Tool
Print to QTR from Print Tool
Print with Quad Tone RIP from Windows
Piezography Glossy Instructions
How to modify the GO Curve
Piezography Digital Negative
Methodology 3 - the silver print
Maintaining a dual purpose film / paper system for Methodology 3
Methodology 1 - alternative process
Maintaining a dual purpose film / paper system for Methodology 1
Alternative Process requiring UV density (by Sandy King)
Making a fine Piezography print
What is Piezography?

Piezography is a system of monochromatic ink shades and media profiles that form a synergistic relationship that allows any user to greatly exceed the capabilities of a supported EPSON printer when making black & white photographs. The original ink set of a supported color EPSON printer is replaced with a black & white only set of Piezography ink shades.

EPSON offers a black & white system (ABW) that uses three shades of black ink along with several color inks to simulate black & white. The Piezography replacement ink set includes in addition to the three shades of black, two additional shades of lighter black and two additional shades of darker black.

Mathematically, a grayscale image divided by three shades of black ink has significantly less fidelity than a grayscale image divided by seven shades of black ink. The EPSON ABW system uses a dithering pattern to assimilate more gray shades by printing dots of ink successively further apart in order to imitate tone. The Piezography Curves by virtue of not needing to use widely spaced dots of ink forces all of the printing to occur at very high frequencies of dithering in which all the dots of ink produced by the printer are so close together they are always touching and as a result, invisible. This is evident by the high peaks of the curves as they produce the gradient. The end result is that the Piezography process prints at a significantly higher output resolution than does EPSON ABW. Further, instead of the hundreds of gray levels available with EPSON ABW, Piezography produces tens of thousands of gray levels making it uniquely suitable for true 16-bit images. It is partly a simple matter of math and it is also a superior ink system in comparison to the OEM.

You can take advantage of all this increased fidelity, shadow & highlight detail, and resolution even if you are printing 8-bit images. All you need to do is follow the workflow in this manual.
Piezography ink is a very unique and sophisticated formulation. There are more than 30 ingredients in a Piezography shade of ink. Unlike other monochromatic ink systems that have appeared since the inception of Piezography (c2000), Piezography shades are not diluted from a single mother concentration. Each Piezography shade is independently formulated to balance the *ab value so that the color tone of each shade is similar from shade to shade in each ink family.

Piezography pigment is carefully ground and shaped in order to produce a uniform spatial reflectance. There is no metamerism. The quality of the image seems to glow and have “depth”. The pigment particle is the only 3rd party ink particle that is micro-encapsulated (as opposed to resinated) so that the static charge is eliminated and the ink formulation can not clog due to agglomeration. Piezography ink is one of the most trouble-free formulations available from any manufacturer. You will find that ConeColor also shares this encapsulation technology. Both inks have been developed by Jon Cone and are not sourced. They are unique to Vermont PhotoInkjet.

There are five main Piezography ink families and three black options. Additionally, we offer an acrylic co-polymer overcoat called Piezography Gloss Overprint which is used to eliminate bronzing and gloss differential. The five ink families are:

**Neutral**: Designed to appear achromatic to the average human observer when printed on Hahnemühle Photo Rag and displayed in a 5000k viewing booth. The ink will appear warmer or cooler depending upon the color of the white paper that it is being printed on. Neutral is a variable tone ink set as a result of paper choice.

**Carbon**: This ink is pure carbon. All other Piezography inks use mostly carbon with trace amounts of other carbon-based pigments to form their final color tone. Piezography Carbon ink, according to the Aardenburg Archives testing results, is the longest lasting ink ever designed by any ink manufacturer. This ink is warm brown gray without appearing warm orange. It was formerly known as Sepia.

**Warm Neutral**: This ink has a slightly greenish bromide warmth. The original 2000 PiezographyBW ink had a similar tone. This ink is very popular among users who favored Agfa darkroom papers.

**Selenium**: This ink was designed to imitate a short bath selenium toning of a fiber based print. Short term selenium toned fiber prints exhibit a slight purply gray tone. This was the standard in the 70s and 80s and is still often used for Museum exhibitions. Selenium is chosen in the darkroom for the additional archival properties. We designed this ink for its aesthetics.

**Special Edition**: This ink commemorates the work that Jon Cone printed for photographer Gregory Colbert for the monumental *Ashes and Snow* exhibits. The complex triple split tones created from custom inks were viewed by more than ten million people world wide making it the most attended exhibition in the history of mankind. *Special Edition* demonstrates that anyone can mix and match Piezography inks. Any shade can be mixed with the same shade of any other ink family.

**Special Edition** is:

1. Piezography Black shade 1
2. Carbon shade 2
3. Blend of 75% Sepia K7 Shade 3 and 25% Selenium K7 Shade 3 for shade 3
4. Blend of 50% Sepia K7 Shade 4 and 50% Selenium K7 Shade 4 for Shade 4
5. Selenium Shade 5
6. Neutral Shade 6
7. Neutral Shade 7
Any of the Piezography inks can be blended as long as you do not mix shade numbers together. In other words and for examples (any shade 2 with any other shade 2 is OK) (any shade 2 with any other shade 3 is NOT OK!) Some Piezography users have blended their own unique ink sets because all of the ink sets use one set of curves when printing K6 or K7 workflow as long as shade numbers are not mixed with other shade numbers.

**Piezography Matte Black:** This ink is known as Neutral K7 shade 1. We provide one matte black ink for all of the ink sets and it is interchangeable.

**Piezography Photo Blacks:** There are two. We sometimes refer to these blacks as MPS. Selenium K7 was our first glossy compatible ink set. Now ALL of the Piezography ink sets are both matte and glossy compatible. Selenium Shade 1 is our standard photo black. You will need to use a photo black when you print on baryta or glossy or luster media. Selenium Shade 1 is the same as Neutral Shade 1 but with many more layers of encapsulation so that the Piezography Gloss Overprint adheres to it. The second and newer MPS photo black is Warm Neutral Shade 1. This black was originally designed for the Piezography Backlit system that is used by Cone Editions Press. This black is very dense (nearly opaque) and can be used by screen printers to make black ink only film. It is also very warm. QuadTone RIP will not reveal its warmth. Those who use StudioPrint RIP and create their own linearizations can realize the warmth from this ink. For normal QTR use the two photo blacks are nearly interchangeable. We recommend the Selenium with Neutral and Selenium inks. We recommend the Warm Neutral shade 1 photo black with Carbon, Warm Neutral and Special Edition ink sets. Of course, we only recommend Neutral Shade 1 for matte black printing. However, Mark Sonners was the first to report that he is using Warm Neutral shade 1 as his matte/photo black simultaneously and says that with QTR the Warm Neutral photo black prints just as dense as the matte black (Neutral Shade 1) if not denser!

**Piezography Gloss Overprint (GO):** This ink is not clear ink base! This is a very special formulation that is designed for use as a second printing over force dried Piezography ink. The Piezography Glossy process is a two-step method. The reason we use two steps is to produce an absolute perfect replication of darkroom process. All EPSON ABW glossy and baryta prints display some amount of gloss differential in which the inks and paper do not reflect at the same rate. Bronzing and metamerism are also indigenous to the ABW process. The Piezography Gloss Overprint when properly applied completely eliminates gloss differential and bronzing.

*Return to Table of Contents*

**Installing Piezography inks in your printer**

Installing Piezography inks in your printer requires paying special attention to our installation procedures. These procedures are available online at [http://www.piezography.com/PiezoPress/technical-support/](http://www.piezography.com/PiezoPress/technical-support/)

They include the correct procedures for purging the color inks from your printer and installing the Piezography shades in the correct slots. It is critical that the shades be installed in the correct slots or the Piezography K7 curves will not function properly.

You can decide whether you wish to flush the color inks from your printer with PiezoFlush or to flush the color inks from your printer with Piezography ink. The main difference, besides the cost of either choice, is that Piezography Shade 7 in a K7 system is installed into the yellow channel. Shade 6 is installed into the light magenta channel. Yellow pigment has a lot of residual stain that will migrate from the dampers and ink lines for a short time. The light magenta also has a strong stain effect Using PiezoFlush short-cuts the process of eliminating the stain. Using Piezography ink and flushing out the color ink is effective but often requires the printing of several sheets of media before all traces of yellow and pink tinting are removed.
The process in desktop printers is easiest. The color carts are removed. The ink stems are wiped clean. The filled Piezography carts are snapped into place. One or two head cleanings is all that is required prior to printing. With large format printers, the ink that is in the ink lines and ink dampers must be flushed out. That requires at least 3 Power Cleans. A 44" printer may waste about 20ml of Piezography ink per ink channel when flushing out the color inks. You must weigh the cost of this times the amount of channels in your printer - versus the cost of PiezoFlush and a set of refillable carts. PiezoFlush carts can be used again to store your printer for a long period of time.

The Piezography Media Profiles

Piezography K7 (K6) is a system of seven (or six) shaded monochromatic inks and matching media “profiles,” that when used correctly produce a perfect black & white ink density linearization on a specific media on a specified printer. Piezography K7 (K6) uses a special profile that I make that is compatible with the QuadTone RIP (QTR). However, it is not a traditional QTR profile that can be made with QTR. As such, it cannot be edited nor can it be used as a base for making additional QTR profiles. A traditional QTR profile is a set of adjustment points for curves that can be manipulated in QTR. This is a process which the user of QTR can learn. However, a Piezography made curve is much smoother, has greater ability to print higher resolution, and is extremely linear from dMin to dMax.

![Piezography Curves](image)

The Piezography Profiler: curves taking shape during development of Piezography Digital Negative. This application, built in-house, is responsible for all of the Piezography curves. The architecture of each shade curve is built by hand. Measurements are made using the DTP-70 spectrophotometer using a 256 gray patch target. When the results are nearly linear, an automated linearization process is performed that produces a linearization that imitates a modified Gamma 2.20. The measurements of each of the ink channels are produced in 16 bit space and truncated to 256 plots for each ink shade, written out in a single .quad file that can be used as a media profile in QuadTone RIP.

Because a Piezography curve uses such complex overlaps of shades, it is very forgiving on a wide range of printers for a given model. It is not considered a “generic”. Having said that, customs are available as a service. A Piezography made curve differentiates between 256 gray levels, and produces these 256 gray...
levels by rendering them with tens of thousands of gray levels. It is the highest possible standard with which you can print your black & white prints.

A Piezography “profile” is actually a set of curves that correspond to what tonal information from an image is printed with a particular ink shade. With six and seven shades of ink, an image is divided in such a way that the tonal responsibility of the inks can be very complex. The QTR curve-generation tool can be mastered by most users who are attempting to control three or four shades of ink. But it is too difficult to produce a perfect linearization with six or more shades of ink. Therefore, Piezography created its own profiling application that can output a QTR “compatible” curve set.

The combined curves set is actually called a “curve” in QTR. Piezography K7 & K6 curves are compatible with the print driver of QTR, but not its curve making tools. Therefore, the Gamma and Ink Limit of a Piezography K7 or K6 curve can’t be adjusted in the QTR interface without adverse effects. But, they should not need to be adjusted in order for the user to have the best results.

Custom curves are available as a service from InkjetMall. This service can be used for having curves made on media that have not been profiled.

Return to Table of Contents

---

QuadTone RIP Installation on Mac OS X

Installation on Mac includes installing the (1) Quad Tone RIP package, (2) Quad Tone RIP Print Tool, (3) the Epson Printer driver and utilities, and then finally (4) the individual QuadTone RIP K7 print libraries.

1) When you download the QuadTone RIP package from http://www.quadtonerip.com you are downloading an installation package that puts a large number of QTR printer packages onto your Mac.

Part of the installation procedure is to complete the installation of the software. The installer does this for you. The other part of the installation is to install the printer libraries that you require. We will address the separate libraries later. All of them are installed during the initial QTR installation. Please proceed with that.

But, please do not use the downloaded Tutorial.pdf for Piezography Workflow. Use this guide that you are reading now!
Follow the on-screen directions provided by the QTR installer.

Selecting your Applications folder is the recommended location for the installation.

Please make sure that you pay the author his shareware fee when you have finished installing the package!

If you are on Mac OS X 10.5 or later, Apple OS X now manages all of your color management behind the scenes to conveniently trip you up when you forget or intentionally neglect to select a color management scheme of your own. Naturally, black & white printing does not use color management. Therefore, in OS X 10.5 and higher, images are converted by Apple OS X prior to printing with varying unexpected results depending upon OS X version. It is apparent that each successive OS release has been experimenting with its users’ non-color managed image files.

The only way to circumvent this is to not use the Print command. A stand alone printing application is required and QuadTone RIP has released Print Tool for OS X 10.5 and higher. Windows users already use a stand-alone QTR application. With Print Tool for OS X, it will manage the Print request and then send it to QuadTone RIP.

2) It is now mandatory to use Piezography if you are on OS X 10.5 or higher. If you are on 10.4.7 for example, you would not need to use Print Tool and you can refer to our earlier users manual for workflow. We recommend that you download and install Quad Tone RIP Print Tool at http://www.quadtonerip.com/html/QTRprinttool.html

Print Tool is installed by downloading the .zip file. Double clicking the .zip file will unpack the application and this should be dragged to your Applications Folder.

3) You must install the Epson printer driver for your printers so that you have a way to perform normal maintenance procedures such as alignment or head cleaning. You should download the latest Epson printer driver from the Epson website. They have a whole section devoted to Support – and you can navigate to your printer and download the most recent package. After you have successfully installed the Epson printer driver and utilities, you will be ready to install the Piezography K7 curves for your particular printer/s.
Finally, you need to navigate to the QuadTone RIP directory on your Mac, find the K7 Quad package for your printer and run the install command. The QuadTone RIP directory is normally installed in your Applications / QuadToneRIP. So look in your Macintosh HD first or where you installed it when you ran the QuadTone RIP installer. Inside this directory are several other directories: Curve Design, EyeOne, Profiles.

Inside of the Profiles directory will be many different possible QTR driver packages. You will only look for those that have K7 as part of their name (such as R2880-K7).

Inside each of these directories is an install command (such as InstallR2880-K7.command ). Simply, select it and open it or double click it.

It will look for the attached printer through USB cable (firewire is not supported) and will install the Piezography K7 curves that are located inside that directory. You must have your printer connected.

Later, if you download additional K7 curves or you have custom curves made – this is where you will move those new curves. All you need to do to install these curves is to run the install command again.

That completes your installation for matte printing Piezography. For printing on Glossy and Baryta papers, it requires installation of the Glossy curves and optional inks. So we will add this in the Glossy Piezography section. For now you are ready to print matte prints with Piezography inks and QTR!

### Supported (though unofficially) Printers not listed

The Epson R1430 is an example of a printer that is compatible with QuadTone RIP but that has not yet been written into the QTR software as of the writing of this manual. QTR is currently at version 2.7.3.

The R1400 (for example) can be used with QTR and it uses the same K6 curves as the R1400. You will need to manually make this setup yourself. It’s not difficult. Follow these steps:

- Create the printer in Print&Fax or Print&Scan in the System Preferences of Mac OS X.
- Name the new printer "Quad1400-K6" and using QTR Epson 14oo driver.
- Now run the Install 14oo-K6 script in the Applications / QuadToneRIP / Profiles /1400-K6 .
Windows Installation of Quad Tone RIP

Windows users can download and install the latest version of Quad Tone RIP from here: http://www.quadtonerip.com/html/QTRdownload.html

The software is an executable and is installed either during the download or after the download. This is always a process that is set by the user when the download link is clicked. We recommend that you install after the download so that a copy of the installer remains on your computer. Please select the Default locations so that QuadTone RIP is installed and appears in your Start Menu. The printer libraries are pre-installed on Windows computers.

We recommend that you install the Epson printer drivers and utilities for your printer so that you have access to the alignment and printer utilities. Without doing so, will you not be able to use QuadTone RIP.

Piezography Workflow Background

Piezography designed curves are very unique. The linearization process that we invented is not a scientific linearization. Rather it is a gamma weighted linearization which uses a very complex mathematical algorithm to produce output that emulates an approximate visual Gamma of 2.20. When we linearize and Piezography curve, it is linear to a modified Gamma of 2.20.

We devised this system because nearly all display systems today have a native Gamma of 2.2 and are most often calibrated to Gamma 2.2. Before Piezography K7, we provided a system called Piezography BW-ICC which printed with a Gamma of 1.80. The reason we chose a Gamma of 1.80 was because most displays were of the CRT type and all of the calibration systems were tuned towards professional graphics use around the D50 standard. Today, out of convenience, the calibration industry has largely ignored that humans are better suited to calibration and color matching under the D50 system. Rather than fight the flow, we produced a printed output that nearly any user can calibrate to in varying degrees of success by calibrating their display to Gamma 2.20.

We recommend that you set up your imaging software to display your images in a grayscale space of Gamma 2.20. Conversely, if you prefer to image in RGB grayscale, the Adobe RGB 1998 color space also uses a Gamma 2.20. In this way, images will be displayed to you with the correct contrast relationship.

However, most displays today are exceedingly bright which makes for very dark shadow display. The brighter the display, the less shadow detail will be evident on screen. Piezography will print much more detail than you can see on our display unless you calibrate to Print standards.

Many of today’s displays such as the sexy Apple Cinema Display HD are ill-suited for Print calibration. On the other end of printability correct display systems are the Eizo CG series and the NEC SpectraView displays which are 12 bit and higher hardware calibrated displays. The latter can be calibrated directly because they are capable of displaying billions of colors. The brightness can be directly reduced without
losing fidelity. The former class of displays (all others) must be calibrated through the computer’s video board. That can very adversely effect fidelity. A video board has only 16.7 million colors (256R x 256G x 256B). The calibration necessarily reduces the output of at least one if not two of the RGB video channels. The end result is reduced visual fidelity of the display. (seems counter to what the Color Management gurus are selling).

Nonetheless, Piezography always prints with the same fidelity whether the display is calibrated or not. The difference is that some users will have displays which can display nearly everything that Piezography has to offer, and other users will have displays that are inadequate for such a high fidelity printing system.

We recommend using hardware calibrated displays (the Eizo CG series or the NEC Spectraview series) if it is critical for you to have a display that is very accurate to the output. Otherwise, in your software calibration package (such as Eye1, ColorMunki, Spyder in order of our preference) select Gamma 2.20 and set the brightness of the display to about 85L or Candelas to reduce the brightness. This will have the effect of creating a display calibration that is about as bright as the ink reflecting off paper. If you prefer very bright displays - you will not be able to see the shadow detail.

The concept behind calibrating a display is to reduce the white point and black point to that of about the light reflecting off paper white and the light reflecting off the darkest black ink on the paper. The contrast ratio between those two points is quite small compared to a very bright display designed more for video editing. In fact, the contrast ratio of today's displays can reach 5000:1, whereas Print requires between 250:1 to 350:1 depending upon the output.

Piezography has so much fidelity that crude and rough imaging techniques that can be swallowed up in the Epson ABW or RGB dither are painfully presented with Piezography printing. Keep in mind also, that the way you image for Epson ABW or RGB printing may be different than how you will image for Piezography.

Piezography reproduces the grayscale of 256 gray values like can no other system! It is entirely possible that because you are not used to printing and seeing the differences between RGB shadow details of 0, 1, 2, 3, 4, 5, etc you may not pay particular attention to shadow detail. And because Piezography can realize the differences in highlights between RGB values of 254, 253, 252, etc you may need to spend more time making sure that you do not blow out delicate highlight detail.

Generally speaking, Piezography images should start out flat without clipping. You may wish to see your images printed first prior to editing them. That would be our recommendation. We don’t think that you should print flat images. To the contrary, you can image to your heart's desire. Just do not throw away valuable highlight and shadow detail in an effort to make a pleasing display image until you see it in print. Unless you have 100% confidence in the calibration of your display, it is worthwhile to see what can be in shadows and highlights. Piezography has the unique ability to render more shadow and highlight detail than any other digital or darkroom process. Go slowly until you have the confidence.

To print with Windows QTR or Mac OS X Print Tool, you should save your images in Tif file format. Other formats may be supported as of this writing,
Using the Quad Tone RIP Print Tool

By now you should have downloaded and installed the Quad Tone RIP Print Tool. This application is quite interesting because it finally allows Mac users to set up multiple images for printing at one time. Think of it as a RIP interface without any printing capabilities. This is where you set the page size and orientation and then place a single or multiple images onto the layout before sending it to the Quad Tone RIP (QTR). Print Tool is required if you are on Mac OS X 10.5 or higher in order to circumvent Apple's new color management scheme for non-color managed image files. All Piezography is non-color managed.

Easy to use. Select the Printer model so that the page setup choices are appropriate for your K7 printer. If your K7 printer does not appear, then you did not install it! Refer to step 4) of the Macintosh installation process. Choose your page setup to match the media you are about to print. Drag and drop images or open and place images. You can resize them individually. If you did your homework and followed our suggestions, the images should show up with Embedded Profiles of Gray Gamma 2.2! That's important! Select No Color Management and click Print! The images will be sent to QTR for printing. We will cover that next.
Print to QTR from Print Tool.

When you clicked the Print button in QTR Print Tool, it sends the job to QTR to print. The Print window comes up as is usual with Mac OS with the Layout Option:

Pull the QTR Print window options menu to QuadTone RIP

Now you can access the Quad Tone RIP interface as follows:
Very easy to set up a print run. You can save the presets to make it easier for the next print. Use 16bit mode for printing 16bit images and 8bit mode for 8bit images. The Paper Feed is set to your printer’s current setup as either sheet or roll and must match the Page Setup from Print Tool or an error will be generated at the printer. We make our curves using the 2880 dpi which is why all K7 curves begin with K7-2880.... The Speed is set to Uni-Directional unless your printer can produce high quality Bi-Directional prints. If it can not - you can located a bi-directional head alignment tool for your printer to allow you to print at higher speeds. DO NOT TOUCH ANYTHING WITH A RED X ON IT- OR ELSE!!!!

At this point, you only need to make certain that you have selected the correct Curve for the paper you are printing. If you want to try a paper that is not supported by a Curve, try testing the unsupported paper with other Curves. Otherwise, you can use QuadTone RIP to create Curves using the Curve Creation Tool. You can get support for this and other QuadTone RIP questions and issues at the www.quadtonerip.com website.

Or contact InkjetMall who is the only authorized provider or Piezography created curves. A low-cost, custom curve making service is available.

Return to Table of Contents
Print with QuadTone RIP from Windows

Launch QuadTone RIP from the Windows Start menu.

You must set up QuadTone RIP when you first use it. It will remember its last settings the next time you launch it.

If your printer is not listed, you need to install the driver for your operating system. Drivers are available from the support section of the EPSON website. If you do need to install a driver for your printer, quit QuadTone RIP before installing the new driver.
You must select the correct printing model for Piezography inks. We supply a large array of Piezography printing profiles (called Curves in QuadTone RIP.) The only way to access these Curves is to select the K6 or K7 Printing Model that is appropriate for your printer model. In this example the Quad 1400-K6 Printing Model is selected.

You must select the correct Curve for the paper you are printing. You only use Curve 1 Setup. With Piezography, you do not need to, and should not set up Curves in Curve 2 and Curve 3.
You should select 2880 dpi if you want to print the smoothest, highest-quality prints. The Curves that have been made by Piezography have been produced using the 2880 dpi setting. In most cases, prints at 2880 dpi have better dMax than at lower resolution settings.

The Speed setting gives you a choice of Uni-direction or Bi-directional. In Bi-directional printing the print head prints in both directions and is much quicker. Most printers can produce high-quality prints in bi-directional mode. However, some printers cannot. It's simply a luck of the draw. However, uni-directional produces a magnificent print. So please try the same test image in both modes to determine which setting you want to use, or must use.

The red crosses are covering an area that you should not make any adjustments to, unless you have created your own Curves using the QuadTone RIP Curves Creator toolset. Piezography uses its own Curve creation system to produce a proprietary format. Adjusting Curve Blending and Advanced Adjustments is not recommended and can severely degrade output quality.

Finally, You can select an image from the File Menu. The image must be in TIFF format. Make certain that when you save your Grayscale single channel files in Photoshop, that you save as TIFF format.
Choose an image from the File menu. If you like, you can set up QuadTone RIP to automatically print any image that is dragged to it. Of course you need to select certain options to prevent oversize images from creating an error alert. You could for example, select the Scale To Fit and Center Images options.

At this point, you only need to make certain that you have selected the correct Curve for the paper you are printing. If you want to try a paper that is not supported by a Curve, try testing the unsupported paper with other Curves. Otherwise, you can use QuadTone RIP to create Curves using the Curve Creation Tool. You can get support for this and other QuadTone RIP questions and issues at the www.quadtonerip.com website.

Or contact InkjetMall who is the only authorized provider or Piezography created curves. A low-cost, custom curve making service is available.
Piezography Glossy Instructions

Piezography Glossy is required for printing on any non-matte paper. Non-matte papers include glossy, lustre, semi-gloss or lustre, satin and baryta. These papers require the Piezography photo black which we call MPS shade 1. There is an MPS Selenium Shade 1 which is neutral and an MPS Warm Neutral Shade 1 which is very warm. All of the other Piezography ink shades are now matte/glossy compatible.

All Piezography Glossy printmaking requires a second application of Piezography GO (Gloss Overprint). Piezography GO does not add significant amounts of gloss to non-matte media and it cannot make matte media glossy. It's main purpose is to remove the bronzing and to absolutely equalize the gloss differential so that it is not possible to see where the ink stops and the paper begins. We try to perfect the look of a darkroom silver print. We think the best results are on the baryta papers when you are trying to emulate darkroom air-dried silver prints.

We keep the glossy curves separate from QTR but we may have them included in the QTR download at some future date. You will find the Piezography Glossy curves as well as the special GO curve at our Piezography website which you will find at: [http://www.piezography.com/PiezoPress/blog/piezography-k7-inks-and-curves/piezography-glossy-curves-library/](http://www.piezography.com/PiezoPress/blog/piezography-k7-inks-and-curves/piezography-glossy-curves-library/)

Eventually these curves will be in an upgrade by QTR.

To use Piezography Glossy properly you must print the image with the inks curve for your supported media. This is then followed by a second printing of GO which uses a special GO curve. The image is not printed the second time. Instead a small white image is printed. Because the image is white and because QTR considers non-printing areas as white, the use of our GO curve with a white image will completely overprint the sheet. QTR has limitations which include 1/8" top and sides and 1/2 inch bottom. QTR cannot bleed print.

**How to use:**

1) Print an image with the K7-glossy curve specific to your printer model and paper at 2880dpi and uni-directional speed, then dry the print either for 24 hours air-drying or a few minutes of low blow drying. We actually recommend the electric blow dryer set on warm. You can move it back and forth over the image that has been freshly printed. It takes only a moment to dry the surface hard enough to withstand a second printing.

2) Make a small (1x1 inch or smaller is fine) pure white (255, 255, 255) 300ppi image in Photoshop, feed the printed sheet back into the printer and print the white square thru QTR by selecting the GO curve at 1440dpi and bi-directional speed to print an even layer of GO over the entire sheet (GO will print evenly over the maximum printable area, depending on the paper size you select).

**How to modify the GO Curve**

The GO curve is an interesting example at looking how QTR uses K7 curves to print. First lets look at a typical K7 curve using the QTR Curve View tool.
This is a Piezography Glossy inks curve that was custom made for a customer using a split tone ink set of Selenium and Warm Neutral inks. The Selenium inks are in shades 7 through 5 represented on this curve view by the color slot location in the printer (yellow, light black, light magenta). The Warm Neutral inks are in shades 4 -1 represented on this curve view by the color slot location in the printer (magenta, light cyan, cyan and black). You can’t tell any of that by looking at the curve view. The paper this curve was produced for was on JonCone Studio Type5. This particular ink combination on this paper is one of the most beautiful Piezography Glossy effects. The split tone is fantastic.

Here is a typical GO Curve. There is only one ink position printing and it does not actually appear to be very curve like. It is actually a single digit encoded into the entire curve. GO is installed in the LLK position. And the value that is normally always kept at 0 for every member of a curve has been changed to 30,000. That value is recorded in the L255 slot of the LLK curve. 255 is always set to 0 so that 0 units of ink will print where ever an L255 value is.

L0 is dMax. An L255 value is white. It is in fact paper white. So if we change the L255 to anything other than 0, some ink will print on the paper margins and any specular highlights of an image that has RGB255 values.

Piezography Curves are rendered from a 16bit mathematical possibility. There can be a theoretical 65,536 possible units of ink printed at any location. So therefore, 30,000 units of GO is about a 45% coverage. We find this amount adequate for most papers. Sometimes the coatings of glossy and baryta
papers beg for a little more or a little less Piezography Gloss Overprint. If you can locate this value in the GO Curve, you can edit it.

The way we edit this value is to duplicate the GO Curve. We then open the GO curve using Text Edit in Mac or Type Pad or similar in Windows. You can do a search for 30000 or simply go to the first value in the LLK curve.

When you first open the GO Curve (and it should be a duplicate that is renamed to the amount you intend to change it to) you will see the header file that describes the amount of ink positions. In this case there are eight ink curves (K, C, M, Y, LC, LM, LK, LLK). We can scroll down to the first value in the LLK curve which will be near the end of the file, or perform a search for 30000.

You can type a higher value for more GO. Perhaps as much as 40000 for a paper like Epson Exhibition Fiber. It is easy to see when too little GO is applied. There will be some bronzing and gloss differential present.

When too much GO is applied, the print will lose sharpness. The amount is too high and it will begin to re-soften the Piezography inks.

If you choose to make a duplicate curve file and open it to edit its text, it is important that you do not Save As or Save because unwanted formatting can be applied. Instead Quit the Application and click Yes when you are asked if you wish to Save before closing. That is why you work from a duplicate and rename the duplicate prior to editing.
Piezography Digital Negative

Currently, we only support process on the Epson R2400, R2880, 3800/3880, 4800/4880, 7800/9800, 7880/9880 printers. All of the digital negative curves for QTR and Piezography inks are compatible only with the above printers. They can be adapted to the new R3000, 7890/9890 and 7900/9900 printers. In the latter, the two additional ink slots of the 7900/9900 will permit simultaneous use in the printer of the digital negative ink set and the regular Piezography K7 printing ink set.

Selenium inks are used because they were originally glossy compatible which makes them adhere and dry permanently to Pictorico Ultra Premium OHP film. Pictorico Ultra Premium OHP film is the only film that we support and for which we have made curves. Technically, any of the Piezography inks can be used for this process because they are all now glossy compatible. However, we have not tested the sensitivity of these other inks to the Piezography Digital Negative curves. Our recommendation is to use the Selenium inks.

The digital negative process involves the use of two new shades: 2.5 and 4.5. We have only made these available pre-bottled in the Selenium ink set. If you are inclined to mix your own 2.5 and 4.5 from Neutral, Warm Neutral, Carbon, etc it is possible that this will work for you. If your process is dependent upon UV absorption - then all of these ink sets might perform differently. We only have index values of the UV of the Selenium inks (thanks to Sandy King).

Introduction

I designed several digital film systems that differ from each other, depending upon the intended use of the film - ranging from silver print to photogravure to silkscreen positive. Mostly, it has been a personal exercise in seeing how density can be used in a methodology that is similar to continuous-tone silver negatives and positives. That is to say, to use inkjet to produce film that gradually blocks light. This is a contrast (no pun intended) to the "UV methods" when color inks are used in conjunction with a process like Mark Nelson's Precision Digital Negatives (PDN).

But, first let me contrast the difference between using color inks to make a negative and using Piezography inks to make a negative.

The Precision Digital Negative process uses conventional color inks to block out certain portions of the UV spectrum in relation to the sensitivity to UV of various darkroom and alternative process. PDN is widely popular - especially among Universities and Colleges which are required to use OEM inks when given free printers by the OEM.

The above images are from Dan Burkholder's excellent "The Modern Digital Negative" and show steps in producing a negative from color inks.
Precision Digital Negative process using color inks can often produce digital artifacts from such extreme color output (the films do not produce natural color). These defects can resemble a pattern that looks like "venetian blinds" in the final print. This is the chief complaint of using PDN. The venetian blinds are nothing more than visually apparent banding produced by pushing the OEM driver to extremes and eliminating some of the color inks that would otherwise be used to fill in the dithering. If a negative appears green, then magenta ink is missing, as are often the light blacks. If a negative appears orange and yellow, then the cyan and light cyan are missing as well as the light blacks. The OEM driver depends upon the entire ink set to produce smooth non-banding output.

A typical Precision Digital Negative is comprise of only one or two of the inks available in a color inkjet printer. These are the colors that the PDN process determines will produce the best range of tone. The above examples are from Andrew Overtoom's "The Undead Neg" blog.

With typical PDN negatives, inks required to fill in the spaces between printer dots of the dithering algorithm are missing. In some printers this can cause a great deal of visual banding. In some print processes, the banding is swallowed up by the lack of resolution from the alternative process papers and emulsion. But, I find that with silver printing - the banding shows up and the highlights are often filled with unwanted "dots".
A Piezography Digital Negative looks like a negative.

Piezography Digital Film differs sharply from PDN by producing dot-less output film that is smooth in tone, looks like a traditional negative, and is used directly under a traditional enlarger or exposing lamp much as traditional film is used. The higher quality output of Piezography Digital Film is a result of using shades of light black ink in conjunction with overlapping curves in QuadTone RIP. This totally eliminates the dithering patterns of the PDN process which is used with the OEM printer driver. When used correctly, Piezography Digital Film can not produce "venetian blinds" or any other banding and digital artifacts. It is especially suited for making fine silver prints in the darkroom. And like all Piezography products, it is turn-key. The user does not need to produce any of their own "curves", nor take measurements and produce experimental processes, nor use PDN (although I tried it.)

Piezography Digital Film is available to those who wish to use my recipes and download my QTR curves. There are several processes from which you can choose. With desktop printers it is easy to try them all because refillable cartridge sets are relatively inexpensive. Also, you can use one set of refillable carts for Piezography Digital Film and then switch effortlessly back to OEM cartridges or standard Piezography print process. But, with large format printers the ink waste is too great to switch back and forth. One process should be standardized for large format printers. (Given a choice it would be my methodology 3.)

So I will start with Methodology 3.
Methodology 3 - the silver print

This is my recommended method for making silver prints. It uses a very unusual and abbreviated ink set of only five shades: 2, 2.5, 3, 4.5 and 5. This ink set can not be used for making regular Piezography prints unless you have this digital negative ink set as an option in the Piezography Selenium ink set for the Epson 4900, 7900 and 9900 printers. Those printer models have 11 ink slots which is enough for a standard K7 ink set, the glossy options, and the digital film options. However, on all other supported printers, there will not be enough ink slots to also use shades 1, 4, 6, and 7. Instead we offer a purging target and a purging method so that you can replace ink shades 2.5 and 4.5 with the shades you will need for K7 printing. You can read that later in this section.

Methodology 3 is adaptable to any silver paper and chemistry. It is also suitable for platinum/palladium printing and even Carbon printing. It is turnkey and should require no adjustments to a Photoshop image unless you wish to modify the contrast. This methodology is not difficult to master. It is designed for photographers who know intimately the density requirements of their work. They have made density measurements of their conventional film and know what works best for the type of silver paper they prefer printing on. However, it works very easily for those who have no idea what density requirements are.

The five density curves also employ a dMin that imitates film base+ fog. The clear part of the film has a density similar to the unexposed film of a traditional negative. The idea being to produce a negative with an ideal density range for your preferred silver paper. If the density readings you are making on your analog film matches one of the film curves, that is the one to use. I use the 1.60 curve for both Ilford RC and fiber base. I can use a full tonal range image and produce a film that produces a full tonal range silver print.

The five QTR curves produce dMax of either 1.40, 1.50, 1.60, 1.70, or 1.80. These are sufficient for all darkroom printing and quite a bit of alternative process. The sixth curve is for Carbon printing process. It does not have a film base+ fog. It’s UV index for dMax is at about 3.10.

![Graph](image.png)

The Piezography Digital Film 1.60 QTR curve for typical silver fiber based paper or RC paper.
The Piezography Digital Film QTR curve for Carbon Print.

These curves are also easily adapted to the Curves Calculation portion of Mark Nelson’s PDN if you wish to alter your output contrast. But, a simple curve in Photoshop accomplishes the same without the specificity of using a second process beyond the inkjet printer. I find PDN to be tedious in process and prefer something more intuitive that works. Still others are very drawn to the complexity of PDN. If you want to use PDN in conjunction with Piezography Digital Film, you do not need to use anything other than the final Curves Calculation of PDN. The only thing it will gain you is creative output contrast.

Without PDN, Piezography Digital Film produces linear output film and is turn-key for darkroom use. I only brought PDN into my development process because of a friend's suggestion to see if I could incorporate it. But, it's not a necessary component of my work. So, if you're a PDN head looking for better output - use it. If you are looking for a turn-key, out-of-the-box high standard solution, do not use PDN with my digital film system. I believe it to be totally overkill. If you want your output more contrasty - then make a simple contrast curve in Photoshop. Spend your time making prints instead!

**Instructions for use**

You must load up a supported printer with the correct Selenium shades of ink according to the QTR curve diagram above. Only shades 2, 2.5, 3, 4.5, and 5 are used. In the remaining ink carts you can either devise to use the other Piezography shades if you intend to swap out the ink sets for regular printing, or you can use PiezoFlush so that the unused print heads do not dry out.

If you are intending to print only film - we recommend using the PiezoFlush in the unused cartridge positions. However, if you intend to purge your printer and swap out the film shades for Piezography shades so that you can print both film and paper - then please read our section on maintaining a dual purpose film / paper system in this section.
The curves can be downloaded and installed into QTR. As if this writing they are not included in the current 2.7.3 download of QuadTone RIP. Please refer to the Piezography Curves section of our Piezography Support system at http://www.piezography.com/PiezoPress/technical-support/.

The Piezography Digital Negative system is turnkey in that it produces very smooth linear film that is capable on its own of producing smooth long toned silver prints. There are five curves supplied that produce a range of tone from dMin (film base+ fog) to 1.40, 1.50, 1.60, 1.70 and 1.80. For my own use, I prefer the curve that produces a dMax of 1.60. It is sufficient to block light and create paper white.

An image in Photoshop is converted from positive to negative using the Image / Adjustment / Invert Image command if a negative is required. It should also be flipped horizontally in Photoshop so that when printed, the film side with the dried ink is in contact with the emulsion for sharpest detail. We recommend the use of a vacuum frame for images larger than 5" x 7".

How I determine which curve to use is to produce a step wedge on Pictorico film using each of the curves. I can fit these all onto a single sheet of film which I contact print. The resulting paper is them exposed at my standard silver neg time and developed in standard chemistry at a standard time. I examine the print to find which curve produces a density nearest to the endpoint that blocks all light. That is the curve I use. Conversely, I can use a denser curve and adjust my exposure time, etc.

Before printing, an image must be Inverted using the Image / Adjustments / Invert Image command in Photoshop and flipped horizontally so that the ink side of the film can be reversed directly into contact with the emulsion.

As with all Piezography digital film - allow the film to dry overnight or simply use an electric hair dryer for one minute. If you hold the freshly printed film so that you can see light through it - you will notice that where it is still not fully dried appears to be brownish or milky. When the film is dry - it should be vacuum frame contact printed if the film image is greater than 5x7 inches. Otherwise, the results will be softer than when used with the vacuum frame.

Maintaining a dual purpose film / paper system for Methodology 3

If you wish to maintain a printing system that allows you make both regular Piezography prints and Piezography Digital Negatives you will need either an 11 ink printer such as the Epson 4900, 7900, 9900 or you will need to purge your printer and replace the two digital film shades (2.5 & 4.5) with shades 4 & 6. The two positions which these shades pairs are in are the magenta and light black.

In a small format printer such as the R2400 and R2880, you will only need to swap the cartridges. In the R3000 and other supported large format printers, we have devised a way in which to purge the ink out of only these two positions using a special QTR Target file while printing in Calibration mode.

The normal layout for Piezography K7 printing and the Methodology 3 ink set are below:

<table>
<thead>
<tr>
<th></th>
<th>K</th>
<th>C</th>
<th>M</th>
<th>Y</th>
<th>LC</th>
<th>LM</th>
<th>LK</th>
<th>LLK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piezography K7</td>
<td>1</td>
<td>2</td>
<td>4</td>
<td>7</td>
<td>3</td>
<td>5</td>
<td>6</td>
<td>GO or Flush</td>
</tr>
<tr>
<td>Piezography Digital Neg</td>
<td>2</td>
<td>2.5</td>
<td>3</td>
<td>5</td>
<td>4.5</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
You can see that if you wish to install the full Piezography Selenium K7 ink set into your printer, you will need only to replace the inks in the Magenta and Light Black positions each time you wish to make prints or film. As mentioned, in a desktop printer this is a simple replacement. On the R3000 and supported Pro printers there will be as much as 18mm of ink in each of the M and LK ink lines that must be first purged out of the printer. You can do this by performing 2-3 POWER CLEANS which will remove all of the ink in all of the ink lines and that will be wasteful, or you can follow the instructions below for using QTR to purge these two ink channels.

**Two channel ink Purge Instructions Methodology 3**

Above on the left is the regular QTR Calibration Mode image. It is a color image that uses specific RGB values to trigger each ink shade to print when using the QTR RIP. Calibration Mode is a special QTR mode that is used when attempting to make your own QTR curves using the QTR Curves Tool. We will use this special mode to purge your printer using a special purge target that is made of two of the patches on the regular QTR Calibration Mode target.

Above on the right is our special purge file (PZDN-X800-Meth3-inkpurge.tif image ) which is provided as part of the Piezography Digital Negative installation. We have enlarged two of the cells on the regular QTR Calibration mode image. These two cells are 100% of the Magenta and the Light Black. We’ve increased their sizes to cover nearly half the printed page. In Calibration Mode, the printer will only print out 100% of the ink in the Magenta and Light Black positions. It will take only a few sheets before you see that the regular shades in these positions have been replaced by the new shades.

**Mac:**
1. Replace either shades 2.5 & 4.5 with shades 4 & 6, or visa versa.
2. Open QuadTone RIP Print Tool
3. Set Page Setup for the printer and paper size you intend to use for purging.
4. Open the PZDN-X800-Meth3-inkpurge.tif image (this image is a very specific RGB color, which controls the M and LK channels when printed thru QTR's calibration mode), you can scale it even larger.
5. Select Printer model and "No Color Management" (refer back to how to print with Print Tool), then click Print to send this purge file to QuadTone RIP.
6. In the Print Window select the QuadTone RIP from the pull down list (layout).
7. In the Mode pull down list, select QuadTone RIP Calibration (which will gray out the three curve pull down lists).
8. Select 100% Calibration Ink Limit if printing on scrap heavyweight, coated/print paper or about 50-80% if printing on uncoated, very thin or typing paper.
9. Select the paper feed: either sheet or roll
10. 1440dpi is fine to select for this purpose, bi-directional will print faster than uni-directional.
11. Click Save.
12. Click the Print button to print this purge page.
13. Repeat 4-12 until you can see that the inks have been fully swapped out. It will be obvious.

Windows:
1. Open QTR version 2.7.2 or higher
2. Select the paper size you wish to print on
3. Select Tools> Options> Calibration Mode, which will automatically open an ink separation image file.
4. Open the PZDN-X800-Meth3-inkpurge.tif image by selecting File> Open (this image is a very specific RGB color, which controls the M and LK channels when printed thru QTR's calibration mode)
5. Select 100% saturation if printing on scrap heavyweight, coated/print paper or about 50-80% if printing on uncoated, very thin or typing paper.
6. Select the paper feed: either sheet or roll; 1440dpi is fine to select for this purpose; bi-directional will print faster than uni-directional
7. Click the Print button to print this purge page.
8. Repeat 4-7 until you can see that the inks have been fully swapped out. It will be obvious.

Once you have the regular Piezography inks installed you can use the regular Piezography K7 curves to make prints on supported media. When you have the Piezography Digital Film ink set installed, you can use the PZDN curves to make digital film.
Methodology 1 - alternative process

This is my recommended method for making alternative print processes which require very high optical density films. It uses a very unusual ink set of seven shades: 1, 2.5, 3, 4.5, 5, 6 & 7. This ink set can not be used for making regular Piezography prints unless you have this digital negative ink set as an option in the Piezography Selenium ink set for the Epson 4900, 7900 and 9900 printers. Those printer models have 11 ink slots which is enough for a standard K7 ink set, the glossy options, and the digital film options. However, on all other supported printers, there will not be enough ink slots to also use shades 2 and 4. Instead we offer a purging target and a purging method so that you can replace ink shades 2.5 and 4.5 with the shades you will need for K7 printing. You can read that later in this section.

I made one film based curve that can produce linearized tonality from clear film to opacity (dMax 3.0) and is only recommended when your process needs to block out a lot of light or you require an optical density greater than that which is provided by Methodology 3. Methodology 3 is better for UV based systems like Carbon print, or density based systems like silver print / platinum... Usually, when there is a need for opaque film, continuous-tone is not desirable. However, some printing out methods do require a great deal of dMax. This film curve is offered because it has a broad density range from which can be adapted by outputting the required range of tone from Photoshop. Having said that, while it can be used for silver print if you clip your Photoshop image enough - there would be some unwanted dots in the highlights with this method for silver - whereas none will appear with Methodology 3. Here is the curve:

![The actual QuadTone RIP curve “PZDN-X800-Meth1”. This process uses Piezography MPS Selenium black shade 1, Selenium shades 2.5, 3, 4.5, 5, 6, 7. You will need to limit your output density in Photoshop according to the dMax required by your alternative process or silver paper. By limiting your output you can fit the image file to the density you require. If the black point of a Photoshop image were reduced from 100% to about 60%, it would produce a film optical density of about 1.65.](image-url)
Instructions for use - Methodology 1

An image in Photoshop is converted from positive to negative using the Image / Adjustment / Invert Image command if a negative is required. It should also be flipped horizontally in Photoshop so that when printed, the film side with the dried ink is in contact with the emulsion for sharpest detail. We recommend the use of a vacuum frame for images larger than 5" x 7". Here is how we go about limiting the output to your desired alt proc.

The image must be adjusted to compensate for the amount of dMax required by the alt proc. If you give it a full range image, the dMax of 100% gray will equal 3.0 optical density. This would not be useful in darkroom printing in which silver negatives rarely exceed 1.70 optical density. It would make for a dynamite backlit film (especially if you use the Warm Neutral Shade 1 ink). But, an alt proc that is continuous tone rarely needs that much optical density.

If you do not know your specific needs, you can experiment by printing out a step wedge that is clearly marked in 5% increments. You should use a standardized exposure time and development time that you normally use with conventional silver film. You can look at the dMin and dMax produced in the alternative process print or silver print and limit the image output to these two gradation points in Photoshop.

Some processes such as silver print require considerable tone before they begin to print highlight details. To help you wrap your head around what needs to be done on your part, here is a simple explanation in relation to darkroom principles and silver printing… When you think of photographic negative film and absolute black on a silver print you think of film base + fog which is darker than the Pictorico film and may be about 0.28 – 0.35. When you think of specular highlight and photographic negative film, you think of a density of perhaps 1.60 – 1.70 of fully exposed film. The mid-point that makes a 50% gray is not half way between these two points, but rather closer to the base point. Light and logarithms and all that…

In making a digital negative with Piezography digital film process Methodology 1, you need to find these values by printing a step wedge through QTR using the curve PZDN-X800-Meth1.quad. This is going to result in a perfect representation of the step wedge input values. We already know that using Methodology 1 that 100% gray is going to print at the maximum optical density of 3.0 which is much to dense for silver print. We also know that Methodology 3 is better suited to systems requiring optical density below 2.0. But, to illustrate how to use Methodology 1 is helps to use an extreme example.

QuadTone RIP supplies a 21 step wedge and a 51 step wedge. Using the standard 21 step file from QTR, making a Piezography digital film and printing it would result in a film that should look like this:

![21 step grayscale linearization](image)

And in some darkroom process this film might produce a print that looks like the below:
The three points are placed to illustrate the desired dMin, 50% and dMax. Remember that 100% ink density produces white and 0% density produces black. These are “negatives”. The same process is reversed in figuring out a film positive for processes such as photogravure.

By simple analysis, it appears that 65% input gray will print as pure white on this particular silver paper/chemistry combination. All of the density from 65% to 100% does not print and is lost. So we need to take 100% input density (which we might have thought to be our specular highlight) and move it to 65% output density so that everything below 100% density in the original digital negative file can print with detail in the silver print.

25% input gray produces a satisfactory mid-point. So we need to transform 50% input density to 25% output density in order for our mid-points to print as mid-points. And finally 5% input gray produces a maximum black. All of the nuances in the 1-4% range are lost. So we need to take 0% input density (pure black) and move it to 5% output density as this will become our pure black once it is printed in silver. Anything lighter than this will now print with some detail.

Now lets see it in terms that are more visual including the Photoshop exercise…
If you did not create a compensation curve, and used the digital film as is to create a silver print, a digital negative image might print like this:

Moving these points that you found as dMin, mid-point, dMax to where they should be would create a Photoshop compensation curve that may look like the below illustration for the above example:
This is the curve that you might use on your inverted digital images before printing them to the Piezography digital film system were your process to imitate this example. But, it is only an example of a curve and it does not mean you do not have to go through the process yourself!

Consequently, this Photoshop curve applied to the digital step wedge image file that is used to make a silver print would convert it to something that when printed would produce a film that looks like this:

You can see how we have used the three points of the Photoshop curve to make an output film that is within the desired tonal range of the intended process.

The above film would produce a print in the darkroom that looks like the below:
I can say that this three point method is simplistic. Many photographers will use densitometry and apply 16 points in a Photoshop curve to perfect things. dMin and dMax are easily found, as is the mid-point. But, silver is not linear, so 1/4 tones and 3/4 tones are probably a requisite. It is not much more difficult to determine 1/8ths… The rabbit hole is as deep as you wish to go. Just keep in mind, that your wet-process must be standardized before starting. You are calibrating your wet-process.

If this Photoshop curves process may seem to you like something that should be built-in to Piezography digital film, it can’t. Everyone’s darkroom process is so different and often very personally arrived at. Each chemistry/paper combination will have a unique compensation. What Piezography digital film offers is a very smooth output process onto the film free of dots, artifacts, and a possibility of realizing far greater resolution of detail than that obtained by using Epson K3 color inks to make a digital negative. It’s a perfect base. Yes, we built a more complex curves process in QTR for Methodology 3 that is suitable for a wide range of alternative processes. If you think you can find out what UV or optical density your alternative process requires, you may be in a better position to choose Methodology 3. You can look up the UV index for Piezography inks in the UV chart prepared by Sandy King here.

Once the curve is obtained for Photoshop and provided that you keep your darkroom chemistry standardized, it will be easy to create a workflow using the saved Photoshop curve that might look something like this:
The image inverted in Photoshop.

The saved Photoshop curve applied to the inverted image.

This image file can now be flipped horizontally and printed using the Methodology 1 curve. The output film will be correct for the intended process.
As with all Piezography digital film - allow the film to dry overnight or simply use an electric hair dryer for one minute. If you hold the freshly printed film so that you can see light through it - you will notice that where it is still not fully dried appears to be brownish or milky. When the film is dry - it should be vacuum frame contact printed if the film image is greater than 5x7 inches. Otherwise, the results will be softer than when used with the vacuum frame.  

Maintaining a dual purpose film / paper system for Methodology 1

If you wish to maintain a printing system that allows you make both regular Piezography prints and Piezography Digital Negatives using the Methodology 1 system you will need either an 11 ink printer such as the Epson 4900, 7900, 9900 or you will need to purge your printer and replace the two digital film shades (2.5 & 4.5) with shades 2 & 4. The two positions which these shades pairs are in are the magenta and light black.

In a small format printer such as the R2400 and R2880, you will only need to swap the cartridges. In the R3000 and other supported large format printers, we have devised a way in which to purge the ink out of only these two positions using a special QTR Target file while printing in Calibration mode.

The normal layout for Piezography K7 printing and the Methodology 1 ink set are below:

<table>
<thead>
<tr>
<th></th>
<th>K</th>
<th>C</th>
<th>M</th>
<th>Y</th>
<th>LC</th>
<th>LM</th>
<th>LK</th>
<th>LLK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piezography K7</td>
<td>1</td>
<td>2</td>
<td>4</td>
<td>7</td>
<td>3</td>
<td>5</td>
<td>6</td>
<td>GO or Flush</td>
</tr>
<tr>
<td>Methodology 1</td>
<td>1</td>
<td>2.5</td>
<td>4.5</td>
<td>7</td>
<td>3</td>
<td>5</td>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

You can see that if you wish to install the full Piezography Selenium K7 ink set into your printer, you will need only to replace the inks in the Cyan and Magenta positions each time you wish to make prints or film. As mentioned, in a desktop printer this is a simple replacement. On the R3000 and supported Pro printers there will be as much as 18mm of ink in each of the M and LK ink lines that must be first purged out of the printer. You can do this by performing 2-3 POWER CLEANS which will remove all of the ink in all of the ink lines and that will be wasteful, or you can follow the instructions below for using QTR to purge these two ink channels.
Two channel ink Purge Instructions Methodology 3

Above on the left is the regular QTR Calibration Mode image. It is a color image that uses specific RGB values to trigger each ink shade to print when using the QTR RIP. Calibration Mode is a special QTR mode that is used when attempting to make your own QTR curves using the QTR Curves Tool. We will use this special mode to purge your printer using a special purge target that is made of two of the patches on the regular QTR Calibration Mode target.

Above on the right is our special purge file (PZDN-X800-Meth1-inkpurge.tif image) which is provided as part of the Piezography Digital Negative installation. We have enlarged two of the cells on the regular QTR Calibration mode image. These two cells are 100% of the Cyan and the Magenta. We've increased their sizes to cover nearly half the printed page. In Calibration Mode, the printer will only print out 100% of the ink in the Cyan and Magenta positions. It will take only a few sheets before you see that the regular shades in these positions have been replaced by the new shades.

**Mac:**

1. Replace either shades 2.5 & 4.5 with shades 2 & 4, or visa versa.
2. Open QuadTone RIP Print Tool.
3. Set Page Setup for the printer and paper size you intend to use for purging.
4. Open the PZDN-X800-Meth1-inkpurge.tif image (this image is a very specific RGB color, which controls the C and M channels when printed thru QTR's calibration mode), you can scale it even larger.
5. Select Printer model and “No Color Management” (refer back to how to print with Print Tool), then click Print to send this purge file to QuadTone RIP.
6. In the Print Window select the QuadTone RIP from the pull down list (layout).
7. In the Mode pull down list, select QuadTone RIP Calibration (which will gray out the three curve pull down lists).
8. Select 100% Calibration Ink Limit if printing on scrap heavyweight, coated/print paper or about 50-80% if printing on uncoated, very thin or typing paper.
9. Select the paper feed: either sheet or roll.
10. 1440dpi is fine to select for this purpose, bi-directional will print faster than uni-directional.
11. Click Save.
12. Click the Print button to print this purge page.
13. Repeat 4-12 until you can see that the inks have been fully swapped out. It will be obvious.

Windows:

1. Open QTR version 2.7.2 or higher
2. Select the paper size you wish to print on
3. Select Tools> Options> Calibration Mode, which will automatically open an ink separation image file.
4. Open the PZDN-X800-Meth1-inkpurge.tif image by selecting File> Open (this image is a very specific RGB color, which controls the C and M channels when printed thru QTR’s calibration mode)
5. Select 100% saturation if printing on scrap heavyweight, coated/print paper or about 50-80% if printing on uncoated, very thin or typing paper.
6. Select the paper feed: either sheet or roll; 1440dpi is fine to select for this purpose; bi-directional will print faster than uni-directional
7. Click the Print button to print this purge page.
8. Repeat 4-7 until you can see that the inks have been fully swapped out. It will be obvious.

Once you have the regular Piezography inks installed you can use the regular Piezography K7 curves to make prints on supported media. When you have the Piezography Digital Film ink set installed, you can use the PZDN curves to make digital film.

Alternative Process requiring UV density
From Sandy King:

If you own a printer that works with Jon Cone's Digital Negative Methodology #3 system I would recommend it for high quality digital negatives for carbon printing. I have installed this inkset on my Epson 3800 and after a couple of weeks of experimentation am getting negatives for carbon printing that are much freer of artifacts than I was ever able to get with the Epson K3 ink set.

Last year I tried Cone's Methodology 1 system with an Epson 7600 but this did not work out to my satisfaction, in part because the digital negative profile created too much UV transmission Dmax, and in part because changing from a digital negative to regular K7 inkset for printing on paper wasted lots of ink. And overall quality was not any better than I was getting with my own profile and the Epson K3 color ink set.

The new Methodology 3 system is a much better solution for those who own one of the supported printers. I am using the Epson 3800 with the Cone Auto Reset cartridges. First, image quality is
very high in that the negatives on Pictorico are very smooth with virtually no digital artifacts (grain, dithering patterns, etc). Second, there are several different quad profiles from which one can select in order to more or less equal the UV density range of your current negatives. And third, with a purge of two inks you can switch back and forth from a system that makes K7 prints on paper, or digital negatives.

One thing you need to bear in mind is that Cone's data for density range is made with optical reading, not UV, so that the profiles give a lot more DR than the ending figure would suggest. For example, there are five PZDN-X800-Meth3 quad profile, from -1.4 quad -1.8 quad. The last figures suggest a DR of 1.4 to 1.8. In fact, for UV printing these DR figures are much higher, about 2.4 - 2.8. This makes them pretty much ideal for carbon printing as one can easily adjust the strength of the dichromate sensitizer to match the DR of the negative. So basically you match the DR of the negative to the ES of your particular carbon process by adjusting the strength of the sensitizer.

I have attached a table that shows the difference between UV and visual light readings for Methodology 1 and 3 step wedges printed on Pictorico.

<table>
<thead>
<tr>
<th></th>
<th>Methodology 1</th>
<th></th>
<th>Methodology 3 – 1.80 Curve</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>UV</td>
<td>Green</td>
<td>UV</td>
<td>Green</td>
</tr>
<tr>
<td>100%</td>
<td>4.5</td>
<td>3.6</td>
<td>3.10</td>
<td>1.92</td>
</tr>
<tr>
<td>95%</td>
<td>4.1</td>
<td>2.85</td>
<td>2.95</td>
<td>1.82</td>
</tr>
<tr>
<td>90%</td>
<td>3.73</td>
<td>2.48</td>
<td>2.86</td>
<td>1.71</td>
</tr>
<tr>
<td>85%</td>
<td>3.26</td>
<td>2.18</td>
<td>2.58</td>
<td>1.60</td>
</tr>
<tr>
<td>80%</td>
<td>2.89</td>
<td>1.91</td>
<td>2.46</td>
<td>1.52</td>
</tr>
<tr>
<td>75%</td>
<td>2.58</td>
<td>1.68</td>
<td>2.34</td>
<td>1.43</td>
</tr>
<tr>
<td>70%</td>
<td>2.28</td>
<td>1.45</td>
<td>2.21</td>
<td>1.35</td>
</tr>
<tr>
<td>65%</td>
<td>2.03</td>
<td>1.28</td>
<td>2.01</td>
<td>1.22</td>
</tr>
<tr>
<td>60%</td>
<td>1.82</td>
<td>1.12</td>
<td>1.84</td>
<td>1.11</td>
</tr>
<tr>
<td>%</td>
<td>Methodology 1</td>
<td>Methodology 3 – 1.80 Curve</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>---------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>55%</td>
<td>1.62</td>
<td>0.98</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50%</td>
<td>1.48</td>
<td>0.88</td>
<td></td>
<td></td>
</tr>
<tr>
<td>45%</td>
<td>1.32</td>
<td>0.77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40%</td>
<td>1.20</td>
<td>0.69</td>
<td></td>
<td></td>
</tr>
<tr>
<td>35%</td>
<td>1.07</td>
<td>0.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30%</td>
<td>0.93</td>
<td>0.51</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25%</td>
<td>0.84</td>
<td>0.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20%</td>
<td>0.76</td>
<td>0.39</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15%</td>
<td>0.69</td>
<td>0.34</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10%</td>
<td>0.58</td>
<td>0.26</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5%</td>
<td>0.35</td>
<td>0.13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0%</td>
<td>0.27</td>
<td>0.09</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*UV and Green densitometer data from two 21 step transmission wedges (0%-100% in 5% increments) printed on Pictorico, one with the Methodology 1 quad curve, the other with the Methodology 3 1.8 quad curve.*
Making a fine Piezography print

We have to set aside that wonderful Ben Shahn quote that "Meaning is in the shape of Content". We have to set aside content, subject matter, meaning, greatness in vision, etc. for this topic. Making a great print is always dependent upon something that transcends both medium and subject. The greatest vision can be interrupted by a poorly made print. In this section, I am only talking about making a fine print – rather than aesthetics or discussing the criteria by which great photographs are judged (with the exception of tone, sharpness, and execution of medium).

Many people think it takes tremendous skill to pull off a fine Piezography print, or that somehow the technique practiced by the Piezographer is responsible for the inherit beauty of a Piezography print. The reality is that it requires only competence to make a fine print. If your Epson OEM skills are deplorable, then Piezography will not correct that. But, if you have the skill to make a good Epson, Canon or HP inkjet print, then Piezography will attenuate that skill. If on the other hand, you consider yourself to be an excellent black and white printmaker with Epson, Canon and HP - then Piezography is going to allow you to fully exceed what you are capable of doing on the OEM systems.

Let's break this down into what one needs to do in order to produce a fine Piezography print.

Because the Piezography system has been pre-engineered to provide great quality that exceeds what the OEM can produce on its own equipment, most of the work has been done for the photographer. The photographer's responsibility is to insure that the system has been installed correctly (http://www.piezography.com/PiezoPress/about/technical-support/), that the system is being used correctly and you have read all of the parts of this manual that relate to installation and printing.

This means that the manual for using QTR must originate from Piezography and not QTR itself, and that the ink assignments are correct, and that a Piezography produced media profile is being used that matches the media.

Naturally, the printer must have routine maintenance performed and the inks cannot be allowed to get stale or settle within bottles, ink lines, and cartridges. In fact, if you leave your large format printer sitting with pigment inks in it for just 2 or 3 weeks, enough pigment will settle to alter the output. Your eyes are not sensitive enough to notice this with color. With Piezography, the ink curves are so critical that any increase or decrease in individual ink density will make what appears to be solarized output. If you do have to leave your printer sit for a few weeks, you can either purge the printer of its inks with PiezoFlush - or simply remove the Piezography ink carts, shake them gently, and then purge out the ink in the ink lines by performing 2 Power Cleans. So heed this warranty to avoid crummy output brought on by printer negligence.

Speaking of printer negligence. Do you perform routine maintenance? Do you keep your capping station clean? How about the print head wiper blades? Have you changed out your ink dampers in the last two years? How about one year? Gosh...we replace ours every six months as a preventative maintenance to insure our studio printers produce the best possible prints with Piezography inks or Epson color inks. Think about treating your printer as you would your camera, your car, your rifle, your stereo, your prized kitchen knife, your body...

Because Piezography with four or as many as seven distinct shades of ink can separate more tonal values than can the OEM three shade systems, it is important to start with very smooth image files that have a long tonal scale. Without going into mathematics and the virtues of using overlapping shades of Piezography inks rather than the interlinking shades of the OEM, the Piezography system produces tens of thousands more gray value combinations than can the OEM. So, think in grays with black & white on...
the ends, rather than think in black and white with grays in between. There is a subtle distinction in where your attention should be.

If you have defects in your image file that may escape the OEM driver, Piezography will faithfully reproduce them. If one prints a high contrast image with few tonal variations, Piezography will faithfully reproduce it, but will not add any additional grays to the print. On the other hand, if the photographer has an image with interesting and contrasting ranges of smooth tone adjacent to each other, Piezography will add a significant amount of beauty to the print that the OEM cannot. Piezography inks are simply beautiful in how they reflect light.

Think tone rather than punch! A fine Piezography print should draw the viewer in, making them want to inspect the beauty of the surface and the detail and the tonal separation. So you need to do that first! Look beyond the aesthetics of your images and towards the aesthetics of your medium. That should go without saying in any medium – but often it needs to be reminded.

If the photographer is interested in fine detail and uses large format film, Piezography, because it uses additional shades of ink rather than depending upon dithering will realize significantly more output resolution than the OEM can. Even though the Epson ABW system is run on the Epson driver and engineered by Epson – does not mean that it is the best way in which to print black & white on an Epson printer. To the contrary, additional shades of ink in combination with the QTR printer driver means that the minute unprinted areas of the paper media as found with the OEM dithering, will instead be filled with Piezography ink carrying detail. In this case, a significant amount of scanning resolution that does not exceed the optical limits of the scanner will produce more detail than the OEM.

In fact, anyone will tell you that anything more than 360 ppi is wasted on the Epson printer driver. But, printing at 1000 ppi with Piezography actually results in significantly more detail. You would not want to add this resolution to the image file by resizing. Resizing is actually less effective as a way to increase the printed image size than simply scaling in the printer driver. But, if your scanner as a high optical resolution, and you do not exceed the amount of silver grains in your negative, by all means scan at the highest optical resolution you can. Optical resolutions are a specification usually much lower than the highest possible setting in your scanners operating software. Check your scanners specifications for its highest optical resolution (not the interpolated resolution).

We can say that smooth tone and high optical resolution are certainly welcome, though not necessary. I routinely shoot with a blackberry cell phone camera and an iPhone and realize beautiful Piezography prints from very low optical resolution. The jpeg artifacting of the blackberry cell phone looks like film grain, and the prints are very smooth and appear to have more resolution that the small cell phone would seem capable of producing. So do not let 6 mega pixels or low-resolution scans frighten you away. I routinely print 3 mega pixel blackberry cell phone images. In fact, I take my cell phone captures very seriously. I have several years worth of portfolios I have produced using blackberry phones. Some of which I have bought for the quirky camera I have become so endeared with.

The old adage of “garbage in garbage out” certainly holds true for Piezography. If the work originates as a scan, it is most certain that the work needs to be scanned correctly. It is still easy to secure drum scanning from studios including Cone Editions Press (Vermont), but its expensive. On large format film, drum scanning definitely allows the process to exceed even one's greatest imagination of what a fine print can be. But, an OEM print would be improved with drum scanning. So it's not a requisite for Piezography – just a shortcut to a higher level of Piezography.

A consumer level scanner such as the Epson Perfection V750 (which I also own) can be used to produce scans provided that the film negative's film base+ fog and fully exposed film leader are chosen as the end points. They can be dMin and dMax if scanned as a negative. However, often consumer grade scanners
scan without imposing some “algorithm of tone destruction” when the negative is scanned as a positive and inverted later in Photoshop. In this case the film base+ fog will end up being the dMin and the fully exposed leader the dMax.

By setting these two end points and turning off automation (the most important thing to do is turn off automation and take responsibility) in the scanner, everything that is denser than film base+ fog and lighter than fully exposed film leader will scan as detail for the print. If you can identify the 50% gray in your negative, try and get that to be the mid-point or about 128 in RGB talk - 50% in grayscale language.

If I sound like I am simplifying it, I am. Scanning negatives for print is an art. But, if you're not sure what you are doing it often is no more than a matter of identifying the white and black points and setting the mid-point. The white and black points should always be the film without exposure and fully exposed so that everything else falls correctly in place. Later as you begin working more and more with your scanner, you may be able to apply a correction curve that maps out more than the mid-point.

Almost all scanners allow the user to set tone curves for correction. When you turn off the auto contrast and auto adjustment features, look for tone curves and end points... It is better to scan in the correct tone space than to repair it later in Photoshop. The same would be said for working with OEM systems!

If your scanner can scan into 16 bit, you can provide most of this correction instead in Photoshop. The condition I am trying to get you to avoid is the auto-correction of negatives during scanning in which the lightest and darkest points are automatically converted to white and black. While that makes for impressive scans for amateurs, it will not allow a fine photographer to control the gradations of a carefully rendered scene. Imagine if a white car was photographed in fog near dusk were automatically scanned. The scanner would heighten the scene contrast. For an amateur trying to render a photo of their beloved old Chevy Nova this might be perfect. For a fine photographer more interested in the fog and the dusk, no contrast heightening is welcome.

Once the film is scanned, or an image captured from a digital camera, it is best to make a proof before making too many Photoshop adjustments. In order to preview your work, you must work in Photoshop using Grayscale Gamma 2.2 as your grayscale workspace setting when you work on your Grayscale file. Gamma 2.2 must be assigned to the file. The reason for this is that Piezography K7 curves print with a Gamma of 2.2. If you prefer to work in RGB Grayscale, then your working space should be a Gamma 2.2 RGB Space such as Adobe RGB 1998. I prefer to use a single channel 16 bit Grayscale. But, QTR will work with 8 or 16bit RGB Grayscale or 8 or 16bit Grayscale images.

Naturally, this means that you need to follow our examples when printing out of Photoshop on Macs. Photoshop versions CS3 and earlier work differently than versions CS4 and later. If you’re on an older version of the Mac OS X (prior to OS X 10.6) you will not be able to use QTR Print Tool and your OS may be converting your images prior to print! Frustrating! So check the Piezography website for how to print with older versions of Mac OS X.

Common mistakes in using QTR are following the QTR Tutorial. Piezography workflow is not compatible with normal QTR workflow. An example would be using the Gray Matte profile as recommended by the QTR manual. You must read this manual. You must follow our instructions or the perfect tonal linearization will not occur. Trying to do things in Piezography without reading my manual, or reading the wrong manual (QTR manual) will be your biggest downfall. Piezography is not compatible with standard QTR workflow. We use a variant to make the K7 curves. You need to follow that variant when you print.

Calibration of the display to an output device is not as easy today as it used to be with CRT displays. So, I advise always that you respond to the print rather than the display unless you can count on the accuracy.
of your display calibration. If you're lucky enough to have a hardware calibrated Eizo like I have, you will find it easy to calibrate to your output using their Navigator and a supported instrument.

But, if you have LCD displays in which the brightness cannot be turned down to match the brightness of a print - you are a little disadvantaged. Often these exceed 110 candelas of illumination. Some like the Apple Cinema Display can reach more than 200! 80-85 is about the correct brightness for calibration to print. 110 would be better for matching to another LCD or to video, or film output that is intended to be backlit. Prints are not that bright. Their dynamic range is very short in comparison to a fully bright display. 200 candelas is about right for making videos for display in dark theaters!

But, in any event, resist doing what most the Photoshop gurus advise about enhancing your images prior to printing. Most of the popular Photoshop gurus do not print Piezography and are more experts in the use of Photoshop than they are fine printing. It is rare to find a workshop that focuses on printing by printing experts.

Those who are experts in fine printing understand that the generalizations made for printing black & white images with color inks systems do not apply to Piezography, because Piezography can print what these color (including ABW) systems can not - and you may wish to include the nether regions of shadows and highlights in your work, rather than punching up the contrast as most Photoshop gurus like to teach. Just make a proof! Look at the proof. Respond to the proof. Let the proof tell you what to do.

In other words, you may not “have” to equalize an image or move the end-points in towards where the first data are in the histogram. You certainly would not have to do that with a subject matter such as low contrast landscape, or the white Chevy Nova in fog at dusk, etc. Make the proof first to arrive at critical decisions like this, rather than following the advice of Photoshop books. We called that willy nilly imaging when you do what you think you are supposed to do without thinking why you are doing it in the first place beyond that you read you are supposed to.

Never sharpen the image unless you are at pixels view (100% magnification). If it looks too sharp - it is! Try this basic setting of unmask sharpening at 150%, 0.7, 0. Take a look at this standard - and use the new Photoshop smart sharpen tools in a way that does not exceed the contrast line built by my USM settings. You should not be able to see contrast lines - they print with Piezography. Contrast lines form between the very light and very dark tone areas of your image when you apply to much sharpening.

**Black?** My University professor said I had to have a “real” black in all my silver prints. It was not until an exhibition of my work in 2003 that I dared not print a pure black and a pure white. An old school photographer came up to me and told me I was “real brave” for making prints like that. He further said he has never seen such naturalistic landscape photography, and noted that they were well beyond the craft he could carry out in the darkroom. I almost shocked him when I said they were digital captures printed with Piezography inks on an inkjet printer. The point is that they were fine prints, and that the use of black and the use of white are not requisites.

Black and white are rarely found in nature. Unfortunately, silver film often can’t capture what is just inside them, and silver paper certainly cannot fulfill what silver captures. So the human eye and many digital cameras can actually capture a much wider range of tone than traditional photographers may be used to. For many coming to digital and Piezography simultaneously – this can be unsettling. Scanning negatives once believed to be too thin or too dense for printing, and capturing full range negatives will reveal detail in shadows and highlights not previously printable in the darkroom. So easy on those Levels! Make a proof and see what you wish to keep in these regions. You don’t have to be brave to make a fine print, but it does crank it up a level when you can fully realize the tone.
Since Piezography only prints black when a pixel has a value of 0. Pixel values of 1 actually print lighter than Black. In an OEM system they won't. In an OEM system black and near black are usually printed as black. The eye can see shadow detail in a Piezography print as it increases from 0. The eye can differentiate every tone from 0-255 in a Piezography print. The seven shades of ink produce tens of thousands of gray values on the print, so this type of tonal separation is part of the correct Piezography process.

So do you really want black where you could instead have detail? Don't just move the end points in to destroy all that wonderful detail. Use a technique like (Where is the black? In the Technical Support section of [www.piezography.com](http://www.piezography.com)) to selectively enhance blacks while keeping many of the other tones untouched.

We were taught to make blacks in silver prints because the darkest gray was so far up the tonal scale. But, in Piezography, the darkest gray is just a hair away from black. So this is the new area for which you have to play with. If you are scanning negatives, silver paper cannot print this area. It's locked into the film like a secret. So this might be new territory for you - and it might appear to make your prints "flat". But, I assure you that with some experience, and the realization that pure black is rare in nature - you will find this the richest area of your Piezography exploration.

Now this is not to say that if you do not wish to have shadow and highlight detail (and prefer to blow these out in favor of a strong black and or white) that your Piezography prints will not be fine. They will be fine representations of that style of printing. I was simply giving a hint as to what the Piezography print can unlock for you.

If you find that you need to correct your exposure, than use a Photoshop curve rather than levels. Of course in Raw you can accomplish so much more. But, if you must rely on fixing with Levels or Curves, choose Curves. Keep the end-points where they are (0, 255) and use the curve to add contrast without clipping the end points, as Levels would do by moving the end-points in. This will allow you to extend the tone outwards towards black and or white as you need, but without losing detail. It will punch some holes in 8 bit images, but unless the move is very severe, the human eye cannot detect as much as you have been told.

When you print, make sure you follow the instructions in this manual rather than the QTR Tutorial that is included in the download of QTR. K7 curves are incompatible with the QTR tutorial workflow. It makes a big difference.

Choose a good paper. If very black blacks are important to you, then you need a paper coating such as found on Hahnemühle, Canson or JonCone Studio papers. Moab and InkPress papers are adequate for images that do not depend upon contrast or deep blacks. They are about a full stop less dark capable than the first papers I suggested (if you are using Piezography inks). If you are using Piezography Glossy, you must overprint with Piezography Gloss Overprint.

Never use a K7 curve that is not explicitly designed for the media you are printing. Custom K7 curves are available from inkjetmall.com. Make certain that your curves follow this format K7(orK6)-2880-xxxxxx.quad where xxxxx is the paper name. All of our K7 and K6 curves are made at 2880 dpi printer settings. All of them start with either K6 or K7. If the one you have selected does not start with the K6 or K7, you have probably not installed your QTR system completely or are using the wrong printer setup. There are many QTR printer setups, but only a few Piezography setups. Read the manual!

Push the button.
Your work is done.

You've made as great a print as you can of your black & white image.

Happy printing,

Jon Cone